The following information outlines the enhancements, modifications and fixes contained in the Medical Director / PracSoft 3.15.2 update, released early 2014. This information is also available for download as a PDF file from the HCN Knowledge Base at www.hcn.com.au/kb. The 3.15.2 release is a cumulative update, and can be installed over 3.15 and later versions.

Contents

3.15.2 Content for Medical Director ........................................................................................................................................ 2
  eHealth .................................................................................................................................................................................. 2
  o PCEHR Assisted Registration Tool ................................................................................................................................. 2
  o Upload Medications to PCEHR and NPDR via eRx ............................................................................................................. 3
  o ‘Participate in PCEHR’ Check Box added to Clinician/User Records ........................................................................... 3
  o PCEHR Status is Checked Automatically .................................................................................................................... 3
  o ‘PCEHR Consent’ column added to the Current RX Tab ............................................................................................... 4
  o Enhancements to the PCEHR Window ........................................................................................................................... 5
  New Ethnicity and Country of Birth .................................................................................................................................. 6
  Assessments ........................................................................................................................................................................... 7
  Australian Defence Force (ADF) Service ............................................................................................................................ 7
  o Record a Patient’s Australian Defence Force (ADF) Service ....................................................................................... 7
  o ADF Post-discharge GP Health Assessment Template .................................................................................................... 7
  o ADF Post-discharge GP Health Assessment Preventive Health Prompt ........................................................................ 8
  Sidebar .................................................................................................................................................................................. 8
  National Inpatient Medication Chart (NIMC) Improvements ............................................................................................ 8
  Pathology Request Performance Improvement ............................................................................................................. 8
  General Options ..................................................................................................................................................................... 8

3.15.2 Content for PracSoft .................................................................................................................................................... 9
  Patient Demographics .......................................................................................................................................................... 9
  o Introducing Ethnicity ......................................................................................................................................................... 9
  o Productivity Improvement to Country of Birth ............................................................................................................... 9
3.15.2 Content for Medical Director

eHealth

- PCEHR Assisted Registration Tool

The PCEHR Assisted Registration tool provides you with a means to help your patients register for an eHealth record at your practice, asserting their identity, and then uploading their application electronically. If successful, the patient will be registered almost immediately, and you can begin uploading clinical information straight away via Medical Director.


Configuring Medical Director for using the PCEHR Assisted Registration Tool

For each user in Medical Director, indicate whether or not they have permission to access the PCEHR Assisted Registration tool; within the user’s record in Medical Director, tick the new PCEHR Assisted Registration check box to grant permission to the tool.

- See ‘Editing Practitioners / Nurse Practitioners’ in the Medical Director Help for further information.
- Further information about PCEHR and its configuration and usage of in Medical Director is available from within the Medical Director Help, and online at [www.hcn.com.au/Ehealth/Overview](http://www.hcn.com.au/Ehealth/Overview)

Accessing the PCEHR Assisted Registration Tool

The PCEHR Assisted Registration Tool is accessible via:

- The HCN Maintenance suite (select the Database Tasks - Medical Director menu item).
- The Windows’ Start Menu > All Programs > Health Communication Network > MD PCEHR ART.
- A shortcut on your desktop.

Double-click Assisted Registration.

- See ‘PCEHR Assisted Registration’ in the HCN Maintenance Help for more information. Two guides are available to accompany the information in the Help, and are available from the HCN Knowledge Base at [www.hcn.com.au/kb](http://www.hcn.com.au/kb):
  - PCEHR Assisted Registration for Adult Patients
  - PCEHR Assisted Registration for Child Patients
Upload Medications to PCEHR and NPDR via eRx

With a patient’s consent, prescriptions can be uploaded to their PCEHR. The National Prescription and Dispense Repository (NPDR) is a subset of a patient’s PCEHR and allows for the creation of an online medication history (for both prescriptions and dispensing). Transfer of medications in this way requires you are registered for ePrescribing and have enabled eRx Script Exchange.

Prerequisites:

- Practitioner is registered for ePrescribing. See **ePrescribing Configuration** in the MD Help for instructions.
- PCEHR is configured correctly. See **Configuring Medical Director for PCEHR** in the MD Help for instructions.
- Practitioner has indicated their participation in PCEHR. See below for details.


‘Participate in PCEHR’ Check Box added to Clinician/User Records

Tick this new check box to indicate that the clinician/user wishes to participate in PCEHR. This check box is ticked by default.

PCEHR Status is Checked Automatically

Medical Director now automatically checks a patient’s PCEHR status upon opening their record. In line with this, the check box labelled ‘Check patient’s PCEHR status as you open their record’ became redundant, and was subsequently removed from user records.
‘PCEHR Consent’ column added to the Current RX Tab

This new column indicates whether the patient has granted consent to add the selected medication to their PCEHR record:

- If PCEHR has been enabled, and the patient has granted consent, this field will read 'To be sent'.
- If PCEHR has been enabled, and the patient has *not* granted consent, this field will read 'Not to be sent'.
- If PCEHR has *not* been enabled, this field will read 'Not enabled'.

The consent indicator can also be changed by right-clicking an item and then clicking the PCEHR consent entry from the menu that appears (or double clicking on the value which is shown in the PCEHR consent column for that medication); clicking this menu item (or double clicking on the current value) displays a dialog box which gives the user an option to change the value of this the field to ‘To be sent’ or ‘Not to be sent’.

Note that the PCEHR Consent menu item will be unavailable if PCEHR has not been enabled. Consent is typically granted via the Enter Dose window during the prescribing process by ticking the associated check box.
Enhancements to the PCEHR Window

- PCEHR documents now reside on a new tab called **PCEHR View**. See below for details of this new tab.

Details of the PCEHR View tab:

- Filter documents by clicking the button at the top of each column.
- Click the **Show Medicare Records** button to retrieve MBS, PBS, ACIR and ADOR records from PCEHR.
- Click the **Show Medicine Records** button to retrieve prescription and dispensed records from PCEHR.
- Click the **Hide/Show Preview** button to hide/show the document preview in the lower half of the window.
- Click the **Create Clinical Document** button to open Letter Writer and create a new CDA eHealth document.

![PCEHR View Screenshot](image)

- New ‘Prescription and Dispense View’.
  - The Prescription and Dispense View is generated in the eHealth record system and can be accessed by participating healthcare providers in PCEHR window.
  - The view displays:
    - The date a medication was prescribed
    - The name of the medication (both brand name and generic name)
    - The strength or dose of the medication (e.g. 2mg, 20mg).
    - The direction for consumption (e.g. take one capsule daily)
    - The form of the medication prescribed (e.g. capsule, tablet, inhaler).
  - Similar information is also displayed for dispensed medications.

Further Details of the Prescription and Dispense View tab:

- **Group By** drop-down list. Groups prescriptions by Prescription, Generic Name, PBS Item Code, Brand Name, No Group.
- **Print** button. Prints the list of prescriptions, exactly as they appear displayed in the window. This means that in order to print all details, the **Expand List** button should be pressed first.
- **Collapse List/Expand List** buttons. Hides/shows details of each prescription.
Hide/Show Preview buttons. Hides/shows the document preview pane in the lower half of the window.

Show More button. View the currently previewed document in the whole window.

See PCEHR in the Medical Director Help for detailed information.

New Ethnicity and Country of Birth

Record a patient’s ethnicity and country of birth via the Patient Details tab of the patient’s record.

The ‘Ethnicity’ and ‘Country of Birth’ data in Medical Director is a subset of that provided by the Australia Bureau of Statistics:

- 1249.0 - Australian Standard Classification of Cultural and Ethnic Groups (ASCCEG), 2011
- 1269.0 - Standard Australian Classification of Countries (SACC), 2011

Multiple ethnicities can be recorded for a patient, if applicable.
• A patient’s Ethnicity will be reflected on the Clinical Window.

![Ethnicity reflect on Clinical Window](image)

See “Country-of-Birth and Ethnicity” within the Medical Director Help for instructions.

Assessments

○ Queensland Workers’ Compensation Certificate Wizard reinstated.

The Queensland Workers’ Compensation Certificate Wizard, removed when Medical Director 3.15 was released, has been redesigned and reinstated, and is available from the Assessments menu within a patient’s record.

See “Queensland Workers’ Compensation Medical Certificate” within the Medical Director Help for instructions.

Australian Defence Force (ADF) Service

○ Record a Patient’s Australian Defence Force (ADF) Service

Indicate a patient’s ADF service history via the Family/Social Hx tab of the Patient Details window.

![Patient Details window with ADF Service options](image)

Options include;

• Never served.
• Current Australian Defence Force – Permanent Member.
• Current Australian Defence Force – Reserves.
• Past Australian Defence Force – Permanent OR Reserves.
• Unknown.

The selection is reflected in the Occupation field on the Clinical Window as shown below.

![Occupation field on Clinical Window](image)

○ ADF Post-discharge GP Health Assessment Template

An ADF Post-discharge GP Health Assessment is now available. This assessment is supplied as a Letter Writer template, accessed from the Supplied tab of the new template window (within Letter Writer, select File > New).
ADF Post-discharge GP Health Assessment Preventive Health Prompt

An ADF Post-discharge GP Health Assessment Preventive Health prompt is now available on the Prompts tab of Medical Director Options (Tools > Options).

This prompt appears if the patient's ADF service is recorded as:

- Current Australian Defence Force – Reserves or Past Australian Defence Force - Permanent OR Reserves. and
- A letter where the subject contains the phrase 'ADF Post-discharge' has not been created for the patient.

Sidebar

- For ease of access, the Sidebar menu item has been moved from under the Tools menu, and is now a top-level menu item located to the right of the Resources menu on the Medical Director front screen and within the Clinical Window.
- The close button has been repositioned to within the Settings menu.
- The following supplied widgets have been updated:
  - Healthshare Fact Sheets – updated to v1.7
  - Image Safe – updated to v0.8.5
  - UHG Insurance Report – updated to v2.3.651

National Inpatient Medication Chart (NIMC) Improvements

- Double-sided printing layout is now supported.
- Selecting more than 8 regular and/or 7 p.r.n medications will now generate multiple charts.
- More than five allergies can now be recorded on the chart.
- The readability of the medication printout has been improved.
- Updated to now use the June 2013 GP e-version NIMC Form.

Pathology Request Performance Improvement

- The pathology request form now loads faster, even with a large address book record.

General Options

- New Show 'loading' message pop-ups check box added to the General tab of Options.
  When scrolling through a list of patient documents, as each document becomes highlighted, information regarding it is accessed by Medical Director, and a 'loading' message is displayed on-screen. Tick this new check box if you wish to hide this prompt. Note that this check box is un-ticked by default.
3.15.2 Content for PracSoft

Patient Demographics

- **Introducing Ethnicity**
  - PracSoft now records patient ethnicity, adhering to RACGP requirements. Multiple ethnicities can also be recorded for a patient, if applicable.

- **Productivity Improvement to Country of Birth**
  - A patient’s country of birth can now be selected from a standard list of countries recorded in PracSoft. To maintain clean and effective patient data, free-text that does not match an entry in the list will be forced to change.